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Working with Files

To visualize data, the data must first be brought into SciAn. The most common way to

do this is by reading data from disk files. This chapter describes the basic concepts of

files within SciAn and discusses a simple icon file browser which allows you to bring

data into SciAn.

Files and datasets

SciAn uses disk files to store scripts, logs, configuration information, and most

importantly, datasets.

Normally, data files are read in using an icon-based file browser window within

SciAn. The file browser is intended to allow access to your data files while in SciAn

and does not provide more complex operations such as moving, copying, or deleting

files. You can also read files by specifying them as arguments on the SciAn command

line. See the reference manual for more details.

The file browser

From any window in SciAn, select New File Browser from the File menu. A dialog

window like the one in Figure 2-1 will appear.

Enter directory name:

/scri4d/a/users/lyons/scian/tour

Revert Cancel OK

Figure 2-1. Directory dialog for new file browser

If you have specified a default directory in the Preferences window (see Chapter 10),

its pathname will appear in the text box. If you have not specified a default, a single

period, representing the current directory, will appear. If you want to open another

directory, you can type in its full pathname or its pathname relative to the current

directory (the directory from which you started SciAn). You can edit the text using

the mouse, arrow keys, text editing menu commands, and function keys as described

in Chapter 1. The Revert button will undo all editing and restore the text to its
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original state. The Cancel button will cancel the dialog without bringing up a new file

browser. Pressing the Enter key on the keyboard or pressing the OK button will

dismiss the dialog and open the directory you specified. If SciAn cannot open the

directory, another dialog window will appear and give you the choice of canceling the

request or returning to the first dialog to edit the pathname. When the file browser

comes up you will see something like Figure 2-2.

/scri4d/a/users/lyons/scian/tour"! 
Z.stf
STF"! 

W.stf
STF

"! 
Terrain.stf

STF

Files

Show all files

Show SciAn files only$#
Open Parent

Open Set Format Show Info

Figure 2-2. File browser

File types

The file browser shows subdirectories as file folder icons and shows files as icons

according to file type (see Figure 2-3). Executable files are recognized by having any

of the executable permission bits set in the mode word. The other file types are

recognized solely on the basis of their filename extensions.

A file which can be recognized as one of the formats that SciAn supports will be

shown as a data file. The abbreviation of the format name will be shown under the

filename of the icon. If the format of a file is not recognized, you can set its format

manually. To see how, see the section on changing file formats below.

Once you have opened one file browser window in SciAn it is easy to move up and

down the directory hierarchy by using the icons and controls in that window.
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Icon File Type Filename Extension

Directory —

Executable —

SciAn data
Must correspond to one of

the installed file readers

SciAn log/script .log

SciAn palette .pal

Text .f, .h, .c, or .txt

Object code .o

Unknown type —

Figure 2-3. File icons in SciAn

Parent directory

The large button in the upper right of the file browser is for moving up one level in

the directory hierarchy. Pressing this button will open a new file browser for the

parent directory, the directory which contains the first one as a subdirectory. If that

window was already open, it will pop to the front. If you are already at the top level of

the directory structure (the ‘/’ directory in UNIX), the Open Parent button does

nothing.

Sub-directories

The subdirectories in a file browser are shown as icons which look like file folders. To

open a new file browser for a subdirectory, select its icon and press the Open button

or choose Open from the File menu. You can also simply double-click on the folder

icon to open it. If that subdirectory window was already open, it will pop to the front.

File filter buttons

The buttons at the top left of the file browser control whether all files are shown in the

window or only SciAn data files, palette files, and log files.

Note In SciAn file browsers, directory folders are always shown. “Dot” files  (files whose names

begin with a period) are always suppressed.
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File information

The file browser also provides a way to get basic directory information about a file,

such as its size, owner, and last modification date. This information is sometimes

helpful when you have been working with more than one version of a file. To get

information about files, select their icons in the file browser and press the Show Info

button or choose Show Info from the File menu. A window like the one in Figure 2-4

will appear. If more than one file was selected, you can use the scroll bar to view the

information for all of the files.

File Info

/scri4d/a/users/lyons/scian/tour

Name

Size

Owner

Mode

Modified

Terrain.stf

14K

lyons

rw- r-- r--

03/22/93 15:27

Figure 2-4. File Information window

Note There is only one file information window in SciAn. If you select a new set of files and

press the Show Info button, the existing File Info window will pop to the front and the

information will be replaced by the information for the new set of files.

SciAn data files

SciAn can read data files in a variety of formats. Many file readers are included with

the distribution of SciAn, and others, such as the HDF format developed by NCSA,

can be linked in during installation. Each file format has a short name of a few

characters as well as a default filename extension SciAn uses to recognize the files.

Most files contain only a single dataset. However, depending on the format, a file can

contain several datasets. The individual timesteps of a dataset can also be distributed

in several files. To find out the details about a particular file format, see the reference

manual.

Reading data files

To read a data file into SciAn, first select its icon in the file browser and then either

press the Open button, or select Open from the File menu. You may also simply

double-click on the icon. If the file is read successfully, one or more dataset icons will

appear in the Datasets Window. If an error occurred while reading the file, an error

message will be sent to the standard error device which is normally the console.
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Once the data files have been read into SciAn, you work with the data using the

Datasets window as described in the following chapter.

Changing File Formats

When the file browser first opens, only files that SciAn recognizes from their filename

extensions are shown. You can still work with data files that have a format installed in

your version of SciAn but which do not have the appropriate filename extension.

First press the Show all files button at the top of the window to show all files. Then

select the file or files whose format you wish to specify and press the Set Format

button, or choose Set Format from the File menu. A dialog window like the one in

Figure 2-5 will appear showing all of the file formats installed in your version of

SciAn. Click the correct format and press the OK button. All of the selected files will

be set to the new format.

Set file format to:

Cancel OK

NONEDAK

G90NXR

P3DSTF

PDBHDF

SYNFF

Figure 2-5. File Format dialog

Note The action of specifying file formats in SciAn only has effect for the current session. The

formats would have to be specified again the next time you run SciAn. It is a good idea to

use the filename extension appropriate to a file’s data format.

File readers

SciAn reads files using file readers. A file reader is an object which can read a

particular file format and create datasets. File readers are identified by their names,

which are the same as the names in the file format dialog. Each file reader can read

one file format.

The parameters of some file readers can be adjusted through control panels. To see a

window containing icons for all the file readers, choose Show File Readers from the

File menu. You will see a window like Figure 2-6. Then, to show the controls for a

particular file reader, select its icon and press the Show Controls button. You will see

a window similar to Figure 2-7.
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File Readers"! 
SY

File Reader"! 
STF

File Reader

"! 
SS

File Reader

"! 
PDB

File Reader"! 
PB

File Reader

"! 
P3D

File Reader

"! 
NXR

File Reader"! 
NFF

File Reader

"! 
JAKB

File Reader

"! "! 
HDF

File Reader

"! "! "! "! "! "! "! 
Show Controls

Figure 2-6. File Readers window

STF

Use "field@time" format for time samples

Default Extension: stf

Save All Settings

Figure 2-7. File Reader control panel

The controls of some file readers may differ, but all will have at least the two controls

shown here. The Default Extension text box gives the file extension by which this

particular file format is recognized. The file extension is the portion of the file name

after the last period. The Use 'field@time' format for time samples check box tells

whether time-dependent data can be specified using the naming convention described

in Chapter 6.

For more information on particular file readers, see the reference manual, Chapter 4,

“File Formats.”
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Working with Datasets

The process of visualization in SciAn involves taking datasets, optionally modifying

them, and using visualization objects to visualize them. This chapter first discusses

some concepts underlying datasets, such as grids, fields, and geometry, then describes

the Datasets window and its controls.

Explanation of datasets

Datasets contain all the scientific data that is accessible to SciAn. Datasets are usually

read in from disk files, as described in the previous chapter.

Datasets contain four possible components: data, grids, geometry, and color palettes.

The data provides the raw scalar or vector data samples. The grid provides the grid

over which the data samples are defined. Geometry provides a way of showing simple

geometric objects. Color palettes map data values or objects onto colors; see Chapter

5 for more information.

Grids

Grids in SciAn provide locations for data points. Grids are sometimes called data

forms because they provide a form for the data and because they are really more

general than what we normally think of as grids. For most applications the term

“grid” is just fine.

Grids in SciAn can be regular, curvilinear, or unstructured. Figure 3-1 shows

examples of the kinds of grids that SciAn can use.

Regular Separable Curvilinear Unstructured

Figure 3-1. Grids SciAn can use

Grids have two kinds of dimensions: topological and spatial.

The topological dimensions give the basic underlying shape of the grid, which does

not change as the grid is deformed. Some people call topological dimensions
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computational dimensions because most computations traverse the data along these

dimensions. The number of topological dimensions is called the topological rank of

the grid. (When the word “rank” is used by itself, it generally means the topological

rank.)

The spatial dimensions give the geometric shape of the grid. Every point on the grid

is located in a Cartesian coordinate system. The spatial rank of the grid is the number

of Cartesian coordinates, or how many numbers are needed to locate a point in space.

The topological and spatial ranks are often the same, but they do not need to be.

Figure 3-2 shows two grids. Both have two topological dimensions, because two

numbers are required to specify a unique intersection in both cases. The grid on the

left is flat, and so has two spatial dimensions, because each point only has an x and y

position. The grid on the right, however, is bumpy, and so has three spatial

dimensions, because each point has a position in x, y, and z.

Figure 3-2. Grids with two topological dimensions

A grid may have any number of topological dimensions as well as any number of

spatial dimensions. Visualization objects generally only work for certain numbers of

topological dimensions and will automatically use implicit filters to deal with grids of

higher dimension. Spatial dimensions higher than three generally have no effect on

current visualization objects and filters, and a 3-D shadow is used.

For structured grids, the number of topological dimensions is defined as the number

of coordinates needed to specify a single sample in the grid uniquely. The structure

of the grid gives connectivity information in each of the dimensions. For unstructured

grids, the number of topological dimensions is defined as the number of layers of

connectivity information above the location of the points. For example, a dataset with

vertices, edges, and planar faces has a topological rank of two. A dataset with vertices,

edges, planar faces, and 3-D cells has a topological rank of three.

A special degenerate case of a nonstructured grid provides a “grid” with only sample

position information, not any connectivity information. In the strictest sense of the

word, this is not a true grid, but for convenience, it is referred to as an unstructured

grid with zero topological dimensions.

Note At the present time, only one grid can be used within a dataset. The work-around for

multigrid data is to define a separate dataset for each grid.
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Fields and geometry

Fields are datasets containing numerical data and a grid. The data in a field must line

up with the grid. Fields may be scalar or vector. They may contain missing data,

which is marked by a special data value.

The geometry capability is provided for cases where it is desirable to include simple

pictures within the visualization. Only very simple geometric primitives are provided:

lines, polygons, spheres, and conic frusta. For more information on geometric objects,

see the NFF file reader in the reference manual, Chapter 4, “File Formats,”

Time dependence

All data, grids, and geometry may be time-dependent. Because time dependence is so

common in scientific applications, time is handled separately rather than as a fourth

spatial dimension. SciAn will automatically interpolate between timesteps if you

desire.

Some file readers are inherently capable of reading complete time-dependent

datasets. Others are only suited for reading single static datasets; however, there is a

naming convention which can be used to specify static datasets as single time slices.

This allows even the static file readers, such as HDF, to read time-dependent data. The

details of working with time-dependent data are described in Chapter 7.

The Datasets window

The Datasets window holds icons of all the datasets which have been read into SciAn.

An example of the Datasets window is shown in Figure 3-3.

Datasets"! 
Terrain%$#

W

%$#
Z

Visualize Visualize As...

Show Controls Modify...

Figure 3-3. Datasets window
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Filling most of the window is an icon corral. This corral shows icons of all the datasets

which have so far been read into SciAn. It does not show icons for derived or

modified datasets.

SciAn only has one Datasets window. If you close the Datasets window, it will merely

be hidden. If you bring it back again by choosing Show Datasets from the

Datasets menu, the same window will be shown again, containing the same datasets.

Dataset control panels

Clicking on a dataset icon and pressing the Show Controls button or choosing Show

Controls from the Object menu brings up a control window similar to Figure 3-4.

Terrain ! 
Terrain

Data: Static scalar field

Memory: 8100 bytes per time step

Range: [1.6307, 3.1866]

Grid: 2-dimensional structured grid

45 by 45%$#
Terrain Palette

Color Palette

Show Controls

Figure 3-4. Dataset control panel

At the top is a short text description giving the type of the dataset and its dimensions.

At the bottom is a corral containing an icon for the color palette of the dataset. You

can select the icon and click Show Controls to bring up the controls of the palette.

How to operate the palette controls is explained in Chapter 5.

At the right is a series of icons which show groups of attributes of the dataset.

Normally, the top icon is selected, which shows general attributes of the dataset.

Datasets may have other groups of attributes, which can be accessed by clicking on

the icon. Because attributes differ between datasets, they are not all described here.

While using SciAn, you can always get help in context on any control or icon. (See

Chapter 1.)

Color palettes

Every dataset has a color palette. A palette is a mapping of values in the dataset to

colors. There are special colors for underflow, overflow, and missing data. Palettes are

created automatically as datasets are read in. The default palette is a smooth hue ramp

from magenta through blue, cyan, green, yellow, and red.
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Palettes of scalar fields map the range of the scalar field onto the colors in the palette.

Palettes of vector fields map the range of the absolute value of the vectors onto the

colors in the palette. Palettes of geometry datasets are simply used to store the colors

of the objects in the order they are read.

For more information on working with color palettes, see Chapter 5.

Modifying datasets

Selecting one or more dataset icons and pressing the Modify button brings up a

window with ways to modify the datasets. This is mostly for future expansion, as all

the important dataset modifications are now automatically done when the Visualize

As button is pressed.


